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Chapter 15

Frame Generator

Frame Generator consists of several tools to automate frame modeling. You can select lines, 

edges, and points to specify the location of members. Frame Generator derives the selections 

into a part. This part is called a skeleton because it provides the framework for the members. The 

skeleton part automatically updates when a change is made to the original geometry, which 

updates the frame member size or position.

Frame Generator gets structural profi les from Content Center. In addition to the structural 

profi les included in the Autodesk® Inventor® libraries, you can author and publish your own 

profi les. This capacity is useful for adding profi les of extruded aluminum, plastic, and other 

materials because the structural profi les in the Inventor libraries are standard steel shapes.

In this chapter, you’ll learn to

 ◆ Work with frame fi les

 ◆ Insert frame members onto a skeleton model

 ◆ Add end treatments to frame members

 ◆ Make changes to frames

 ◆ Author and publish structural profi les

 ◆ Create BOMs for Frame Generator assemblies

Accessing Frame Generator Tools
The Frame panel, shown in Figure 15.1, is on the Design tab of the Assembly ribbon. It has tools 

specifi c to Frame Generator plus the Beam/Column Calculator from the design accelerators.

Figure 15.1

Frame Generator tools 

on the Design tab of the 

Assembly ribbon
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The tools fall into four categories:

Creating Frame Members  Frame members can be created using the Insert Frame and 

Change tools.

Creating End Treatments  End treatments can be created with these tools:

 ◆ Miter

 ◆ Trim To Frame

 ◆ Trim/Extend

 ◆ Notch

 ◆ Lengthen/Shorten

 ◆ Remove End Treatments

Performing Maintenance  Maintenance can be performed with the Frame Member Info and 

Refresh tools.

Performing Calculations and Analysis  Calculations and analysis can be performed with 

the Beam/Column Calculator.

About Frame Generator

Th e Frame Generator application is an add-in that uses the Inventor application programming 

interface (API). Since the API does not provide access to all the Inventor functionalities, there are 

some user interface diff erences between add-ins and core Inventor tools. For example, the edit 

fi elds in the core Inventor tools have an extensive fl yout menu. Th e add-ins do not have access to 

this functionality, so their edit fi elds are more limited.

Exploring the Frame Generator File Structure
When you create the fi rst members in a frame assembly, a dialog box prompts you for fi lenames. 

Frame Generator creates a subassembly and a skeleton fi le in the parent assembly. The subassem-

bly does several things. It acts as a container for the skeleton and frame members, isolating them 

from the assembly solver, and it acts as a fi lter so Frame Generator tools, such as Frame Member 

Info, ignore other assembly components. The skeleton fi le is created in the subassembly and con-

sists of all of the edges and points you select when placing frame members. Each frame member is 

created as a separate fi le and saved into a subdirectory named after the frame assembly.

As an example, imagine you create a cube to use as the basis on which to model a frame. You 

name the cube fi le Cube_Frame and then place this cube into an assembly called Cube_Frame_
Assembly. Both fi les are saved in a folder called My_Frames. You could then use the cube to cre-

ate a basic frame, using each of its edges as a placement reference for the frame members. When 

you create the frame, you will be prompted to supply the following items:

 ◆ A new frame fi lename and location; these are the name and location of the frame 

subassembly.

 ◆ A new skeleton fi lename and location; these are the name and location of the frame skel-

eton reference.
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If you just accept the defaults, you will end up with a folder such as \My_Frames\Cube_

Frame_Assembly\Frame\. In this folder (once you have saved the top-level assembly), you will 

fi nd an assembly fi le named Frame0001.iam and a part fi le named Skeleton0001.ipt. Special 

attributes in the frame subassembly contain references to the parent assembly. This enables the 

frame skeleton to maintain references to the other assembly components. Figure 15.2 shows the 

default frame subassembly and skeleton fi le naming.

Make Sure You Save

When you click the OK button to create the Frame Generator assembly and place the fi rst mem-

bers, a folder is created in the directory. However, like all Inventor fi les created in the context of 

an assembly, the parts are not written to disk until you save the assembly. Th is is true when you 

create frame members as well, and since it is so easy to create members, it may not be obvious that 

you need to save them after the initial creation. Pay attention to the Save reminders and limit the 

amount of data you risk losing between saves.

Copying Frames

If you have a completed frame design that you would like to copy, you can use the iLogic Design 

Copy tool (see Chapter 20, “iLogic”) to do so. Keep in mind that you needn’t have used iLogic to 

use the iLogic Design Copy tool for copying frames. You can fi nd the iLogic Design Copy tool by 

closing all of your Inventor fi les and then going to the Tools tab and looking on the iLogic panel.

Use the Assemblies list panel in the iLogic Design Copy dialog box to select the frame assembly you 

want to copy. All fi les referenced by the frame assembly will be selected in the other lists. You can 

then specify a target folder to copy to and specify a naming prefi x or suffi  x as needed.

Once you start the copy process, the frame fi les will be copied, and the internal references will be updated.

Note that there are a couple of limitations to be aware of. First, you cannot create more than 

one frame subassembly in the same assembly. Another limitation is that you can’t use copies 

of the frame generated with the assembly Copy tool in other assemblies and maintain Frame 

Generator functionality.

Figure 15.2

Creating a new frame
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Exploring the Anatomy of a Frame Member
Frame Generator initially creates frame members the same length as the selected geometry. 

When you add end treatments, the length is adjusted to make the member longer or shorter. To 

accomplish this, the structural profi les are created with a From-To extrusion between two work 

planes, as shown in Figure 15.3.

When the part is fi rst created, the start plane is coincident with the XY plane, and the end 

plane is set to the initial length. When an end treatment is added, the start or end plane is 

moved to shorten or lengthen the member.

The parameter relationships that control the length are complex. Three parameters drive the 

length, two parameters are driven by those parameters to determine the length, a reference param-

eter reports the overall length, and a parameter is used in the BOM, as indicated in Figure 15.4.

Figure 15.3

A typical frame member

Figure 15.4

Frame member 

parameters



INSERTING FRAME MEMBERS | 717

c15.indd 10:45:48:PM/05/09/2014 Page 717

Table 15.1 lists the length parameters.

Table 15.1: Frame member parameters

Parameter Description

B_L Th e initial length of the member.

G_OFFSET_START Th e off set value of the start work plane.

G_OFFSET_END Th e off set value of the end work plane.

d13 Th e parameter for the start work plane. It is driven by G_OFFSET_START.

d14 Th e parameter for the end work plane. It is driven by G_OFFSET_END.

d19 A reference dimension that measures the overall length of the part.

G_L Th e length parameter that is used in the BOM. It is equal to the reference 

dimension.

Inserting Frame Members
The process for inserting frame members can be broken down into three basic steps. You select 

the frame member profi le (this comes from Content Center), select the placement geometry for 

placing the frame members, and then adjust the orientation of the frame members.

Specifying a Structural Shape
The left side of the Insert dialog box, shown in Figure 15.5, has a series of drop-down fi elds for 

specifying the structural shape.

You use the Standard, Family, and Size fi elds to select the member from Content Center. 

These fi elds are progressive from top to bottom, with one updating when changes are made to 

Figure 15.5

Frame Member 

Selection group
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the one above it. However, the update behavior varies depending on the fi eld selected. If you 

select a new standard, the fi rst family is automatically selected. If you select a new family, the 

size is not automatically selected.

Changing the Orientation
After you have selected the placement geometry, you can change the position and orientation of 

the member. A thumbnail of the profi le is displayed in a grid of radio buttons that control the 

position of the member, as shown in Figure 15.6. These positions are based on the rectangular 

bounds of the profi le. As a result, the corner positions of a pipe that’s 1 inch in diameter are the 

same as they are in a 1-inch-by-1-inch square tube.

You can fi ne-tune the placement position by entering values in the horizontal and vertical 

offset fi elds. You can also rotate the member. For example, food processing equipment fre-

quently has horizontal members rotated 45 degrees so spilled food doesn’t build up on top of 

square tubing.

The Mirror Frame Member button is shown in the lower-right corner of Figure 15.6. This but-

ton is used for profi les that don’t have rotational symmetry, such as C-channel and angle iron. 

The orientation changes affect all the members of a select set. Depending on the geometry, it 

might be more effi cient to use a batch select tool and change the orientation of a few members 

afterward, or you might want to select only those members that have a similar orientation.

Since structural shapes are extruded, Frame Generator needs a method for determining the 

extrude direction. When an edge is selected, Frame Generator uses the closest endpoint as the 

start of the extrusion. Depending on where you select an edge, the same radio button can cause 

the member to be in a different position. The thumbnail is the view of the profi le looking at the 

XY plane. It takes some practice to get a good feel for the relationship between how an edge is 

selected and the behavior of the radio buttons. Once you understand this relationship, you will 

be able to predict the behavior and use it to increase your productivity.

“Do I Need to Use 3D Sketches with Frame Generator?”

Although you can use 3D sketches to base a frame on, you don’t need to do this. You can create 3D 

solids or surfaces to create a frame base. Once you have a 3D shape, you can then add 2D sketches 

to the various faces and use those sketches as selection edges as well. So, you don’t need to be well 

versed in the 3D sketch tools to create 3D frames.

Figure 15.6

Orientation group
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When you’re using a custom profi le with an alternate insertion point defi ned, the Custom 

Point control is enabled. This adds another insertion point to the nine standard ones. The cus-

tom point is not displayed in the thumbnail image, so you should confi rm that the preview is in 

the expected position relative to the selected edge. Figure 15.7 shows a profi le with an alternate 

insertion point.

Selecting Placement Geometry
When selecting placement geometry, you can select edges of 3D models and visible sketch lines, 

or you can select two endpoints. For instance, if you had a cube-shaped base solid, you would 

use the edges to place vertical and horizontal frame members. To place diagonal cross bracing, 

you would use the corner endpoints.

Insert Selection Methods

When you use the default Insert Members On Edges option, you can select edges and lines for 

placement references. Using edges for placement allows you to insert multiple members at once. 

When you use the Insert Members Between Points option, you select two vertices or endpoints. 

This method allows you to place only one member at a time. The most common placement 

method is by selecting lines and edges. This allows the most fl exibility in geometry selection 

and the use of batch select tools.

There are two philosophies for placing frame members. Some people like to place frame 

members individually, making sure each one is in the correct position and orientation. Others 

like to place as many members as possible and then edit them as necessary. The method you 

choose will depend on the type of models you work with, how much effort you put into setting 

up the skeleton models, and, most importantly, the way you like to work.

Batch Select Tools

Frame Generator has several tools for selecting geometry. Multi Select is the default selection 

mode. The standard methods for creating a Multi Select selection allow you to select individual 

edges, use selection windows, and use the Shift and Ctrl keys to add and remove objects to or 

from the selection. In addition to Multi Select, two other select modes are available in the con-

text menu shown in Figure 15.8; they are Chain Select and Sketch Select.

Figure 15.7

Profi le with an alternate 

insertion point
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Chain Select automatically selects all lines and edges that are tangentially connected to the 

selection. Chain Select will not follow past a point that has multiple lines or edges, even if one 

of them is tangential. For instance, if you have a rectangular sketch profi le with rounded cor-

ners, you can use Chain Select and select just one of the lines or arcs, and all of the others will 

be added automatically. By contrast, if you have the same profi le in a 3D shape, Chain Select 

will not automatically select the edges because each edge of the 3D shape has multiple edge 

intersections.

Sketch Select selects all the lines in a sketch. You can select the sketch in the browser or click 

a line in the graphics window. For instance, if you have a ladder-shaped sketch, you can use 

Sketch Select and automatically select the rungs and rails all at once.

The Merge option is enabled when there are connected lines or edges. Merge combines the 

selections into one member. Although Merge is useful when you want to have one continuous 

member, you cannot add end treatments to merged members.

Creating a Basic Frame
To create an elementary frame, you’ll use a prepared fi le that has been set up for you. If you have 

not already downloaded the Chapter 15 fi les from www.sybex.com/go/masteringinventor2015, 

please refer to the “What You Will Need” section of the introduction for the download and setup 

instructions.

The prepared fi le you’ll be using is an assembly fi le consisting of just two parts and the 

frame subassembly. One of the parts contains an unconsumed sketch that you will use to 

place frame members. The frame members will be automatically placed in the predefi ned frame 

subassembly. When creating your own frame designs from scratch, you’ll be asked to supply 

the name and locations for the frame subassembly and skeleton fi les. In this design, you’ll add 

frame members to be embedded in a monument base to support a sign plate:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_15a_001.iam located in the Chapter 15 directory of your Mastering 

Inventor 2015 folder and click the Open button.

 3. From the Design tab, click the Insert Frame button.

 4. Set the Standard drop-down box to use the standard of your choice.

 5. Set the Family drop-down box to use a square tube or square hollow section profi le.

 6. Set the Size drop-down box to use an 80 mm×80 mm (or 3”×3”) section, using a wall 

thickness of your choice.

 7. Select the middle vertical sketch line on the back of the sign plate in the model.

Figure 15.8

Select mode 

context menu

http://www.sybex.com/go/masteringinventor2015


INSERTING FRAME MEMBERS | 721

c15.indd 10:45:48:PM/05/09/2014 Page 721

 8. Use the radio buttons in the Orientation area of the Insert dialog box to orient the frame 

member so it matches up with the square cutout in the base.

 9. Select the other four vertical sketch lines as well. Note that the two end members are not 

centered in the cutouts.

 10. Holding the Ctrl key, select the two end members to remove them from the selection.

 11. Click the OK button to generate the frame members; then click the OK button in the 

Frame Member Naming dialog box to accept the defaults.

 12. Click the Insert Frame button again and click the bottom half of one of the outside verti-

cal sketch lines.

 13. Use the radio buttons in the Orientation area to orient the frame member so it matches up 

with the square cutout.

 14. Select the bottom half of the other outside vertical sketch line and notice that the frame 

member preview does not match the cutout.

 15. Using the Orientation radio buttons, you’ll notice that none of the solutions allows both 

members to match the cutouts.

 16. Holding the Ctrl key, click one of the frame members to remove it from the selection.

 17. Select the sketch line again, this time toward the top, and you’ll see that this fl ips the ori-

entation to provide the correct solution.

 18. Uncheck the Prompt For File Name check box (found along the bottom of the dialog box). 

This suppresses the fi lenaming dialog prompt and automatically accepts the default nam-

ing for the frame members.

 19. Click the OK button. Your assembly should resemble Figure 15.9.

Figure 15.9

Frame members placed 

using Frame Generator
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In this simple example you explored the basics of placing frame members, noting the use of 

the Ctrl key on the keyboard to remove selections. You also noticed that orientation of frame 

members is sometimes infl uenced by the location of your lines or edge selections. You can close 

this fi le without saving changes and continue to the next section. In the next example, you’ll 

explore more selection and orientation options.

Where Are the Other Common Sizes?

You might note that there are several common sizes you use daily that are not listed in the Size 

drop-down. Th is is because Inventor includes only the sizes that are ratifi ed to the various structural 

shape standards. Of course, most mills produce other sizes commonly used in general design. You 

can add those sizes using the Structural Shape authoring tools.

In the following steps you will explore the offset, rotation, and merge options, as well as the 

context menu selection options:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_15a_002.iam in the Chapter 15 directory of your Mastering Inventor 

2015 folder and click the Open button.

 3. From the Design tab, click the Insert Frame button.

 4. Set the Standard drop-down box to use the standard of your choice.

 5. Set the Family drop-down box to use a fl at bar section profi le.

 6. Set the Size drop-down box to use a 50 mm (or 2-inch) bar, using a thickness of 

your choice.

 7. Right-click in the graphics area and set the selection method to Chain Select.

 8. Click any part of the C-shaped sketch and notice that the entire sketch loop is selected; 

you don’t need to click each sketch segment.

 9. Set Horizontal Offset to -100 mm.

 10. Set Rotation to 90 degrees.

 11. Click the Merge check box to ensure that the result is a continuous piece of rolled fl at bar 

rather than a piece for each segment of the loop.

 12. Click Apply to create the frame member.

 13. Right-click in the graphics area and set the selection method to Sketch Select.

 14. Select any of the segments in the ladder sketch and notice that the entire sketch is 

selected.

 15. Set the horizontal offset to 0 mm and the rotation to 0 degrees.

 16. Click Apply to create the frame members.
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 17. Right-click in the graphics area and set the selection method back to the default Multi 

Select option.

 18. In the Placement area of the Insert dialog box, click the Insert Members Between Points 

button and then select endpoints of the gap in the C-shaped sketch.

 19. Set the rotation to 90 degrees.

 20. Click the OK button to create the short length of fl at bar and close the dialog box. 

Figure 15.10 shows the fi nal result.

As you can see, the selection options along with the offset, rotation, and merge options allow 

you to create frame members using just a simple sketch and still get a varied result. You can 

close this fi le without saving changes and continue to the next section.

Aligning Frame Members
Frame Generator follows two rules to give a frame member its initial orientation. If you are 

creating the fi rst member in a selection set, the member is aligned to adjacent geometry or the 

coordinate system. For the rest of the selection set, Frame Generator tries to align the members 

to the fi rst selection. These rules work well for most rectangular machine frames. However, if 

part of the frame is at an angle and there isn’t a good reference, Frame Generator might select an 

orientation that doesn’t match your design intent.

The frame in Figure 15.11 has two sketch lines running down from the center point to be 

used for supports. The members for the base and back have already been inserted, and the two 

angled supports need to be inserted. When a member is inserted on angled lines, the orientation 

is skewed, as shown in the inset in Figure 15.11.

Figure 15.10

Flat bar frame members
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To resolve this, a reference line can be selected fi rst to establish the orientation, and then the 

angled line can be selected to add the support member and have it follow this orientation. Once 

the angled line is selected, the reference line can be deselected, and the angled line will hold the 

proper orientation, as shown in Figure 15.12.

Using reference geometry for angled frame members is a bit of an art. If you regularly create 

these types of frames, you will develop a feeling for the ways that Frame Generator aligns mem-

bers, and you will learn when and how you need to add references. To better understand the use 

of reference geometry for alignment, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_15a_003.iam located in the Chapter 15 directory of your Mastering 

Inventor 2015 folder and click the Open button.

 3. From the Design tab, click the Insert Frame button.

 4. Set the Standard drop-down box to use the standard of your choice.

 5. Set the Family drop-down box to use a rectangular tube or rectangular hollow section profi le.

Figure 15.11

Skewed orientation

Figure 15.12

Using a helper line to 

establish orientation
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 6. Set the Size drop-down box to use a 100 mm×50 mm (or 4”×2”) tube, using a thickness of 

your choice.

 7. Ensure that the placement option is set to Insert Members On Edges and that the offsets 

and rotation fi elds are set to zero. Set the orientation to be centered and then click the 

diagonal line that runs into the frame peak.

 8. Click the OK button to create the member.

Notice how the frame member is coming in at a skewed orientation. To resolve this, you 

will fi rst delete this member and then place another, but this time you’ll use a helper edge 

to establish the orientation.

 9. In the browser, expand Frame_MI_1503 so you can see the frame members.

 10. Hover over each member until you see the one you just created highlighted in the graph-

ics area (it should be at the bottom of the list).

 11. Right-click it and choose Delete With Frame Generator.

Using this option not only deletes the part but also cleans up any end treatments involv-

ing other members related to the deleted one.

 12. Click the Insert Frame button again. Click the diagonal line that runs into the frame peak 

fi rst and then select the Align check box.

 13. Click the sketch line located in the base of the frame to use as the alignment selection.

 14. Adjust the rotation angle by 90 degrees.

 15. Click the OK button to create the frame member in the correct orientation.

Keep this alignment trick in mind as you create frames, and you will likely fi nd it to be very 

helpful. You can close the fi le without saving changes.

Using the Change Tool
You can use the Change tool to change the standard, family, size, material, color, and orientation 

of an existing frame member. You can use the check boxes to set the various options to allow or 

prevent changes. To see the Change tool in action, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_15a_004.iam located in the Chapter 15 directory of your Mastering 

Inventor 2015 folder and click the Open button.

 3. From the Design tab, click the Frame panel drop-down arrow.

 4. Select the Frame Member Info button from the list.

 5. Click one of the shorter uprights in the frame. The Frame Member Info dialog box dis-

plays the information about this part. Click Done to close the dialog box.

 6. From the Design tab, click the Change button.

 7. Click one of the shorter uprights in the frame again and then select the other one. Notice 

that the selection allows only one frame member to be selected at a time.
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 8. Click the Multi Select check box in the Change dialog box and then select the other short 

upright member.

 9. Click the Change Orientation check box and then set the rotation to 45 degrees.

 10. Change the Appearance setting to Cadet Blue or something similar and then click the OK 

button.

This simple exercise demonstrates the use of the Change tool to modify frame members. 

Keep in mind that if you make a change that requires a new fi le to be generated, such as chang-

ing the size, the old part will be replaced with a new one but the old fi le will remain in the 

folder in which it is saved. You can close this fi le without saving changes.

Adding End Treatments
The end treatments are among the most powerful Frame Generator tools. As you add end treat-

ments, the frame member length automatically updates. The end treatments also carry over if you 

change the frame member to a different profi le. End treatments are listed under the frame member 

node in the browser and can be accessed by expanding the browser node, as shown in Figure 15.13.

You can delete end treatments from the browser, or you can use the Remove End Treatments 

tool found on the Frame drop-down list of the Design tab. When you use the Remove End 

Treatments tool, all end treatments are stripped from the selected frame member.

If a member has end treatments on it already and you attempt to add another, you will need 

to select the Delete Existing End Treatment(s) check box in the dialog box; otherwise, an error 

such as the one shown in Figure 15.14 may be created.

Figure 15.13

End treatments in the 

browser

Figure 15.14

Confl icting end treat-

ment error
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If you do encounter an error, simply undo the change and reapply the end treatment, this 

time using the Delete Existing End Treatment(s) option.

Miter
The Miter end treatment makes angle cuts on two members. Figure 15.15 shows the Miter dialog 

box. You can miter multiple members by applying the end treatment to each pair of members. 

You can add a gap between the members by entering a value in the gap input box. The default 

gap is split between the two members. If you want the gap to be taken from just one member, 

you can use the Miter Cut At One Side button, and the gap will be taken from the fi rst member 

you selected. Figure 15.15 shows the gap option buttons and input box.

The default selections cut along an angle, resulting in full-face contact between the members, 

as shown in Figure 15.16. Bi-sect Miter splits the angle between the members. Figure 15.17 shows 

that the cut is located where the centers of the two members intersect.

Figure 15.15

Miter dialog box

Figure 15.16

Th e standard miter joint 

has full-face contact

Figure 15.17

Th e optional bi-sect 

miter cuts both mem-

bers at the same angle
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Figure 15.18 shows a one-sided gap where the horizontal member was selected fi rst.

Figure 15.19 has a miter end treatment between the two angled members and a vertical mem-

ber running through them. The vertical member needs to be mitered to fi t. Figure 15.19 shows 

the left member and the vertical member being selected for the fi rst step to create the miter.

The vertical member still needs a miter to trim the other side, so the miter is repeated with 

the same settings, this time choosing the member on the right and the vertical member, as 

shown in Figure 15.20.

Figure 15.18

Miter gap on one 

member

Figure 15.19

First miter cut

Figure 15.20

Second miter cut
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The resulting miter, shown in Figure 15.21, requires two cuts on each member. An alternate 

method that produces a more cost-effective joint can be made using the Trim/Extend To Face tool.

You can open the fi le mi_15a_006.iam to explore the Miter tool. Practice creating miter gaps 

and two- and three-member miters to understand the process.

Trim/Extend to Face
This end treatment is the only one that can trim multiple members at once. When trimming or 

extending to a face, you select the members you want to trim and then select the cutting face. A 

separate end treatment feature is created for each frame member. If you edit or delete the end 

treatment for a particular member, it does not affect the other members. Figure 15.22 shows a 

typical trim-to-face situation. You would select the vertical member for the member to trim and 

the top face of the horizontal member as the face to trim to.

This end treatment can also be used to create miters. Applying miter end treatments to 

already mitered frame members results in a costly complex joint cut for all three members. 

Trimming the third member to fi t the fi rst two angled members using the Trim/Extend To Face 

tool results in the less-expensive detail shown in Figure 15.23.

You can open the fi le mi_15a_007.iam to explore the Trim/Extend tool. Remember, you can 

select multiple frame members to trim to the same face. Experiment with this fi le as you like—

there is no set solution to the fi nal frame outcome.

Figure 15.21

Resulting miter joint 

between the three 

members

Figure 15.22

A trim-to-face scenario
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Which Side Is Trimmed?

Be aware that when using the Trim tools in Frame Generator, the short end is always the one to 

be discarded.

Trim to Frame Member
This end treatment trims or extends both members so they are fl ush. The fi rst selection is made 

fl ush to the second selection, and the second selection butts up to the fi rst. Figure 15.24 shows 

the selections, and Figure 15.25 shows the results.

You can open the fi le mi_15a_008.iam to explore the Trim To Frame tool. Experiment with 

this fi le as you like—there is no set solution to the fi nal frame outcome. If you cannot get the 

result you want from the Trim To Frame tool alone, consider the Trim/Extend To Face tool as 

well. These tools are often used together to achieve a specifi c result.

Notch Frame Members
The Notch tool cuts one frame member to match the other. It uses the profi le to create a cut-

ting surface. By default you can’t create an offset, so the cut is an exact match. This is simply 

Figure 15.23

Creating a miter 

using Trim

Figure 15.24

Trim To Frame 

selections
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a cut operation, so the frame member is not shortened or extended before the cut. If you have 

authored a notch profi le into a custom frame member library fi le, you can select the Apply 

Notch Profi le check box; however, if the member does not contain a notch profi le defi nition, the 

check box is grayed out.

If you were to notch the shorter I-beam shown in Figure 15.26, which extends past the taller 

I-beam, the extra lump would remain on the left, as shown in Figure 15.27. If the members don’t 

intersect, the notch will have no effect.

Because of this, it’s often best to create a notch as a secondary end treatment. For example, 

if you had two intersecting frame members as shown in Figure 15.26, it might be best to add a 

Trim/Extend To Face end treatment fi rst and then use a notch to remove any intersecting mate-

rial. To explore the Notch tool, open the fi le mi_15a_009.iam. Use the fl anged beams to create 

notches in the T-shaped members.

Figure 15.25

Trim To Frame results

Figure 15.26

Frame members before 

notch

Figure 15.27

Th e result of remov-

ing the intersecting 

material
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Creating Accurate Notches

Notch shapes are driven by manufacturing requirements. Typically, the shape is simplifi ed to reduce 

cost, and there may be a gap between the members to allow for tolerances. Th e easiest way to create 

these shapes is to add a Trim/Extend To Face to make the member the correct length and then add 

an iFeature to trim the end of the member to the correct shape. You can also defi ne notch profi les 

in custom frame member defi nitions.

Lengthen/Shorten Frame Member
You can use the Lengthen/Shorten tool to change the length of a frame member. By default, 

frame members are initially assigned the length of the reference edge or the distance between 

selected points. However, you will often need to change the length. Much of the time you will 

simply use another frame member and one of the Extend or Trim tools. Sometimes, though, 

there isn’t another frame member you can use as a reference, so in those cases you would use 

the Lengthen/Shorten tool.

When you use the Lengthen/Shorten At One End option, the Extension value is applied to the 

end closest to the pick point, meaning that if you select a vertical frame member toward the top 

end and specify an extension length of 100 mm, that value will be applied to the top end. When 

using the Lengthen/Shorten At Both Ends option, the Extension value is applied to both ends. So 

if you applied a 100 mm extension value, the frame member would grow 100 mm on both ends for 

a total of 200 mm. If you enter a negative value, the frame member will be shortened.

Frame End Treatments Are Not Exempt from Design Intent

You should spend time planning your frame design to minimize the number of end treatments 

required because each end treatment is an opportunity for the model to fail if a change is made. 

For example, if you create a skeleton to the inside dimensions of a frame, you can off set members 

during placement so the members butt against one another without adding end treatments.

Reuse Frame Members
When you use the Insert Frame tool, Inventor creates a new part fi le for each new frame member 

you insert. This allows you to create separate part fi les that allow separate end treatments. For 

instance, you might initially insert two identical frame members but then choose to miter both 

ends of one but only one end of the other. Having two separate part fi les allows this. 

However, there are often times when you might want to reuse the same frame member over 

and over. In these cases you would prefer not to have separate part fi les and could use the Reuse 

tool to ensure that the same part fi le is being reused as needed. To see the Reuse tool in action, 

follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_15a_005.iam located in the Chapter 15 directory of your Mastering 

Inventor 2015 folder and click the Open button.

 3. From the Design tab, click the Reuse button.

 4. For the Source Member selection, click the longer existing member from the graphics area.
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 5. Click the longer sketch line to use as the Placement selection, but be sure to select it at the 

end of the line furthest from the existing short member (near the sketched arc).

 6. Click the OK button to create the new frame member and notice the direction of the holes.

 7. Next click the Change Reuse button.

 8. Choose the member you just created and then click the Reverse Member Direction but-

ton; then click the OK button to see the change. Notice the direction of the holes again.

 9. Click the Miter tool and select the ends of the two original frame members when they 

come to an intersection and then click Apply.

 10. Still in the Miter tool, click the remaining end of the short member and the corresponding 

end of the new long frame member (even though it is already mitered) and then click the 

OK button.

 11. Click the Reuse button and choose the shorter member for the Source Member selection.

 12. Choose the remaining straight sketch line for the Placement selection and then click the 

OK button to create the new frame member.

 13. Click the Change Reuse button, select the new short frame member, set Orientation Angle 

to 180 degrees, and then click the OK button.

 14. Click the Miter tool and select the unmitered end of the original longer member and the 

corresponding end of the shorter member; then click the OK button to create the miter. 

The Reuse and Change Reuse tools offer powerful options for working with repetitive frame 

members in your frame designs. Keep these tools in mind when working with frame design, and 

you can likely simplify your frame bill of materials and save yourself some work along the way. 

Here are a few things to know about the Reuse and Change Reuse tools:

 ◆ The Reuse tool is available only to straight frame members and will not work for curved 

members.

 ◆ To convert a frame member created with the Reuse tool to a separate frame member fi le, 

you can locate it in the browser and then right-click it and choose Break Reuse Member. 

 ◆ When you use Break Reuse Member, you will lose any existing end treatments found on 

that member.

 ◆ Frame members created using the Reuse tool might not be selectable for some end treat-

ment and other frame modifi cations tools.

 ◆ If you modify the frame base inputs on which a Reuse frame member relies, such as the base 

sketch, an error message will display, and you will likely need to delete the Reuse member.

 ◆ You can delete a Reuse member by locating it in the browser and then right-clicking it and 

choosing Delete with Frame Generator.

 ◆ In addition to the Orientation Angle options, you might need to use the Align check box 

in the Reuse and Change Reuse dialog boxes in order to reuse members so that they are 

placed in the correct orientation.
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When you’ve fi nished exploring the Reuse and Change Reuse tools, you can close this fi le 

without saving changes and continue to the next section.

Maintaining Frames
Maintaining existing assemblies can be time-consuming. Frame Generator provides several 

tools that help streamline the process of modifying end treatments and determining how 

frames were originally designed.

Remove End Treatments
The Remove End Treatments tool removes all end treatments from a selected frame mem-

ber. You can also select multiple members for the batch removal of end treatments. This is 

handy if you need to change the end treatments on a few members or if you have to rebuild 

a frame. You can find the Remove End Treatments tool in the Frame drop-down list indi-

cated by the small black arrow on the Frame panel of the Design tab. (See Figure 15.1 earlier 

in the chapter.)

Frame Member Information
The Frame Member Information tool is used to query frame members. It displays the family 

and size information, mass properties, and material. This is a useful tool because it quickly 

gives you information about a member. For example, it can help you quickly determine the dif-

ference in the wall thickness of two similarly sized hollow tubes. Since the tool fi lters for only 

frame members, you can use it at any level of the assembly. You can fi nd the Frame Member 

Information tool in the Frame drop-down list indicated by the small black arrow found on the 

Frame panel of the Design tab.

Refresh
The Refresh tool is a Content Center tool. It checks Content Center for the latest revision of the 

members in the frame. If a newer version is available, it will prompt you to replace it. End treat-

ments are retained during refresh, but other features, such as holes, are not carried over to the 

new member. You can fi nd the Refresh tool in the Frame drop-down list indicated by the small 

black arrow on the Frame panel of the Design tab.

Managing Frame Generator Files

Frame Generator uses an algorithm to create default fi lenames. You can rename the fi les as you 

create them, when prompted by the Frame Member Naming dialog. But often this slows the design 

process and requires you to enter information you may not currently know.

Another approach is to let Inventor apply the fi lenames automatically. To do so, you can uncheck 

the fi lenaming prompt check box in the Insert Frame dialog box, and Inventor will create the fi le-

names and save the fi les to the location specifi ed when the frame subassembly and skeleton fi les 

were initially created. It is a good idea to set the frame subassembly and skeleton fi lenames and 

locations to use a well-planned naming scheme, whether you specify the frame member names or 

let Inventor do so.
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If you decide to accept the default fi lenames, it is a good idea to use the BOM Editor to set the part 

number iProperty for each fi le to match your standard. In this way, you have a unique identifi er for 

each part member. You can set two identical frame members to have the same part number so they 

are rolled up together in the BOM. Using part numbers (you can think of them as mark numbers), 

rather than the fi lenames, to manage the frame members provides a more fl exible and real-world 

workfl ow for the typical frame design.

Once part numbers have been defi ned, you can also set the assembly browser to use the part num-

ber rather than the fi lenames. Th is allows you to quickly index individual frame parts more easily. 

Do this by selecting the Assembly tab, clicking the drop-down list on the Productivity panel, and 

choosing the Rename Browser Nodes tool.

Although Frame Generator can create frames (and therefore a lot of part fi les) quickly, once the 

frame is modeled, you should slow down and take the time to manage part numbers. Th is allows 

your design to be managed properly in the detailing and revision stages.

You can fi nd a supplemental PDF fi le called Frame Generator BOM in the Chapter 15 directory 

of your Mastering Inventor 2015 folder.

Performing Calculations and Analysis
Included in the standard Frame Generator tools are two calculator tools: the Beam And Column 

Calculator and the Plate Calculator. These calculators are design accelerator tools that can do a sim-

ple stress analysis. The Beam And Column Calculator, for instance, can analyze a single beam or col-

umn, but it assumes a uniform cross section, so it does not take into account holes or end treatments.

If you have Inventor Professional or Inventor Simulation, you can use the Frame Analysis 

tools that are part of those packages. You can learn more about the Frame Analysis tools in 

Chapter 17, “Stress Analysis and Dynamic Simulation.”

Th e Beam and Column Calculator
You can fi nd the Beam And Column Calculator tool in the Frame drop-down list indicated by the 

small black arrow found on the Frame panel of the Design tab. As with other design accelerator 

dialog boxes, the message pane at the bottom and the calculation results pane on the right side 

can be opened and closed by clicking the small >> symbols. You can drag the splitter bar (double 

gray lines) to resize the panes, or you can double-click the splitter bar to open or close the panes.

Calculating Section Properties

As you explore the subjects in the following pages, you can refer to the conveyor assembly in the 

fi le mi_15a_014.iam. Take a moment to open this fi le from the Chapter 15 directory to become 

familiar with it. You will use this fi le to complete the exercise steps presented later.

Select an Object

In this assembly, the Beam And Column Calculator might be used to calculate the loading on 

the power roller supports. When one of the gold tubes is selected, the calculator automatically 

loads the section properties from Content Center, as shown in Figure 15.28. Although Content 

Center has most of the section properties, be aware that some data is missing. You can use sev-

eral methods for determining the properties.
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Use the Region Properties Tool

Inventor has a tool to calculate the properties of a closed sketch profi le. If you want to use this 

tool for the section properties of a frame member, you can open the frame member, place a 

sketch on one end, and project the face. Once you have the profi le, select the Inspect tab, and 

click the Region Properties tool on the Measure panel. Select the profi le you want to analyze 

and click Calculate. The basic region properties for any closed loop are calculated. You can then 

calculate the rest of the properties based on those results.

The region properties are calculated with respect to the sketch origin. Depending on the pro-

fi le, you may have to edit the sketch coordinate system to locate the sketch origin at the center of 

the profi le.

Use the Section Button

Another option for calculating section properties is to use the Section button in the Beam And 

Column Calculator. When you click the button, a list of geometric shapes appears. When you 

select a shape, a dialog box like Figure 15.29 appears and allows you to enter dimensions. The 

calculated properties assume sharp corners and constant thickness, so the results won’t be accu-

rate for profi les with tapered fl anges but may be good enough for many applications.

Figure 15.28

Th e section properties 

for a selected object are 

loaded from Content 

Center

Figure 15.29

Calculating sec-

tion properties for a 

rectangle
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The Flip Section button is used to change the orientation of the x- and y-axes. The z-axis is 

always in the direction of the extrusion. Gravity is always in the negative y-axis direction, so it is 

important to make sure the calculation coordinates match the assembly coordinates. If the beam 

is at an angle, you have a couple of options for handling gravity. You can place a copy of the 

beam horizontally in the assembly. If you want to ignore the effect of gravity, there is an option 

on the Beam Calculation tab to turn the gravity load off.

Both Beam and Column calculations are available. The Beam calculations focus on defl ec-

tion based on loads and supports. The Column calculation checks for buckling. You can select 

Beam, Column, or both calculation types. The Calculation tabs are turned on and off based on 

the selections.

The default material properties do not correspond to a material style and are not linked to 

the style library in any way. Instead, these materials provide you with a starting point and an 

example of the required properties. You can enter properties for a particular material, or you 

can select one of the generic materials listed. When you check the box, a dialog box appears with 

materials such as gray cast iron, steel, and aluminum. These properties can be used for initial 

calculations, but for more accurate results, you should enter the properties for the particular 

alloy you are using.

The following steps use the power roller supports found in the conveyor assembly 

mi_15a_014.iam. Follow these steps to enter the member data into the dialog box:

 1. Click the Beam/Column Calculator button to start the calculator. Recall that this but-

ton can be found in the drop-down list indicated by the small black arrow on the Frame 

panel of the Design tab.

 2. Select the lower, gold-colored support for the power roller.

 3. If necessary, click the padlock icon for the Section Length row in the table, thereby 

unlocking it for editing. Change the value to 12 inch.

 4. Click the Section button and select Rectangle from the drop-down list.

 5. In the Rectangle dialog box, enter the tubing dimensions. Enter 1.5 inch for the outside 

dimensions (B and H) and 1.125 inch for the inside dimensions (b and h). Then click the 

OK button.

 6. Select both the Beam and Column calculation check boxes in the Calculation Type area.

 7. Click the check box next to the Material fi eld to launch the Material Types dialog box. 

Select Steel and click the OK button.

 8. Note the Yield Strength of 44000 psi.

 9. Leave this dialog open because you will use it in the next set of steps, where you’ll work 

with loads and supports.

The coordinate system alignment is correct for this example. So in this case, gravity could be 

ignored, but having the correct orientation simplifi es adding the loads and interpreting the results.

The dialog box should look like Figure 15.30. Note that all the section properties except 

Shear Displacement Ratio are calculated. This property is optional for the calculations. 

Comparing the calculated values with the original ones, Section Area and Moments Of Inertia 

are close but higher.
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The Beam Calculation Tab

The Beam Calculation tab, shown in Figure 15.31, has controls for defi ning the loads and sup-

ports for beams and columns as well as the calculation options. The Engineer’s Handbook (hid-

den away in the Power Transmission panel drop-down list; it’s called Handbook) contains the 

equations used in the calculations. You might want to review those equations before using the 

calculator.

Figure 15.30

Model data entered 

into the Beam And 

Column Calculator

Figure 15.31

Th e Beam 

Calculation tab
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Loads & Supports

The Loads & Supports area contains controls along the top and a browser pane for adding and 

removing loads and supports for the frame member. All of the controls can be accessed by using 

the buttons at the top or by right-clicking and choosing them from the context menu in the 

browser pane area.

The drop-down menu switches the browser between Loads view and Supports view. The 

controls, shown in Table 15.2 and Table 15.3, change depending on whether Loads or Supports is 

set to current.

Table 15.2: Loads buttons

Button Description

Adds a force.

Adds an axial force.

Adds a distributed force.

Adds a bending moment—a single twisting force perpendicular 

to the z-axis.

Adds a torque load—a twisting force around the z-axis. Two 

equal and opposite torque loads are required.

Adds a combined load—any of the forces added at the same 

point on the beam.

Table 15.3: Supports buttons

Button Description

Displays the Options dialog box

Adds a fi xed support

Adds a free support

Fixes one end of the beam
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The Options dialog box, shown in Figure 15.32, gives access to visibility controls for the 2D 

and 3D previews. By default, the loads and supports dynamically update to maintain the same 

size as the view scale changes. You can turn off the automatic update and set a static scale value. 

The Options dialog box is the same whether it is launched from the Loads control or Supports 

control.

Figure 15.32

Loads & Supports 

Options dialog box

Each load or support can be edited in the browser by double-clicking or by clicking the 

browse (…) button. A Properties dialog box displays controls for specifying the location, size, 

and direction of the force.

Calculation Properties

The Calculation Properties group, as shown in Figure 15.33, has four controls that adjust how 

the calculations are made.

Figure 15.33

Th e Calculation 

Properties group

The Use Density check box adds gravity as a load. This is selected by default. The Use Shear 

Displacement Ratio check box is used when calculating the twist angle caused by torsional 

loads. The value is determined by the profi le shape. It is also called the form factor of shear. This 

check box is selected by default.

The default setting for Number Of Beam Divisions is 1000. Increasing the number of divi-

sions can result in improved accuracy for longer beams. You should experiment with different 

values to see whether the number of divisions causes a signifi cant change in the results.

Mode Of Reduced Stress has two options for modeling the stress distribution. The Huber-

Mises-Hencky (HMH) method is based on the maximum-energy-distortion criterion, and the 
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Tresca-Guest method is based on the maximum-shearing-stress criterion. The HMH method is 

the default selection.

Results

The Results pane on the right side of the Beam Calculation tab updates when you click the 

Calculate button. Warnings will appear in the lower pane if the calculation indicates that 

stresses are too high.

For the conveyor example, the support will be welded to the frame at one end and unsup-

ported at the other. The power roller weighs 150 pounds, and the torque is 40 pound-feet. The 

torque causes the power roller to twist between the supports. The edge of the fl at is 1.5 inches 

from the center of the power roller. This means the reaction force at that point is 320 pounds. 

Both the weight and the reaction force are split between the two sides. Follow these steps to 

explore the results and calculation workfl ow:

 1. Ensure that the fi rst load type is set to Radial Force.

 2. Click the … button to add a force for the power roller weight.

 3. Enter 10 (inches) for the distance and 75 (pounds-force) for the force. This is the maxi-

mum distance for the power roller. Click the OK button to close the Radial Force 

dialog box.

 4. Click the Add Torque button to add a torque reaction force.

 5. Enter 11.12 (inches) for the distance and 160 (pounds-force) for the force and then click 

the OK button.

 6. Click the drop-down list to switch from Loads to the Supports browser.

 7. Delete the Free support by selecting it and then clicking the red X button.

 8. Click the drop-down arrow for the Fixed support and select Restraint.

 9. Leave the Use Density option checked.

 10. Deselect Use Shear Displacement Ratio since you don’t have a value for that property.

 11. Click the Calculate button and compare the reduced stress to the yield strength of the 

specifi ed material.

 12. Leave this dialog open and use it to explore the next topics.

The dialog box should look like Figure 15.34. Note that the forces are displayed in the graph-

ics window. If you hover over a force arrow on the model, a tool tip displays the information. 

You can drag the force to a different position, or you can double-click the force to display the 

properties dialog box.
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Figure 15.34

Loads & Supports 

data entered into 

the calculator

The Beam Graphs Tab

On the Beam Graphs tab, the Graph Selection pane allows you to select the results you want to 

display. The selected graph displays in the bottom of the Graph area. At the top of the Graph 

area is a schematic of the beam, supports, and loads. You can drag the supports and loads to 

different positions to update them. If you double-click a support or load, the properties dialog 

box displays so you can directly edit the data. The Calculate button is not available on the Beam 

Graphs tab, so you need to switch back to the Beam Calculation tab to update the results.

The Beam Graphs tab is primarily intended for reviewing results. Twenty-two graphs are 

available on the tab. This example is a pretty simple analysis. You should experiment with 

other loads (torques and bending moments) and support types and then view the results on the 

graphs.

The Column Calculation Tab

The Column Calculation tab checks for column buckling. In the Loads area, you enter the axial 

load and the safety factor and select a coeffi cient for the end loading conditions. When you click 

the … button, a dialog box appears with four end conditions. If you have different end condi-

tions, you should enter the proper coeffi cient from a reference book.
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You shouldn’t need to enter any data in the Column area. The length, section area, and least 

moment of inertia are carried over from the Model tab. The reduced length value is calculated 

by multiplying the length by the end coeffi cient.

For example, imagine that during transport, the frame shifts and the power roller supports 

slam into the trailer wall. The power roller was removed during shipping, so the supports take 

all the force from the impact, estimated at 4,000 pounds evenly distributed across the four sup-

ports. Set the axial load to 1,000-pound force, and click Calculate to determine whether the 

supports will buckle. Figure 15.35 shows the results.

Figure 15.35

Column calculator 

results

HTML Results

When you click the Results button in the upper-right corner of the dialog box, an HTML page 

appears with all the data, calculation results, and graphs. You can save or print this fi le for your 

records.

File Naming

The File Naming button, found next to the Results button in the upper-right corner of the dialog 

box, allows you to specify the calculation’s fi lename. When you click the OK button to exit the 

Beam And Column Calculator dialog box, a subassembly fi le is created in the assembly fi le. 
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This subassembly fi le is just a container for the calculations, allowing you to access them again 

at any point. A browser node is created for the calculations. To edit the results, simply right-click 

the browser node and choose Edit Using Design Accelerator.

Publishing Frame Members
Frame Generator’s frame member library is integrated with Content Center. The authoring and 

publishing process is similar to that used to create any custom Content Center fi les. Since Frame 

Generator requires specifi c modeling techniques, the authoring process will make some changes 

to the model and the parameters to ensure that all of the required parameters are included.

Authoring a Part
The authoring process for a frame member is similar to component authoring. The Structural 

Shape Authoring tool, located on the Part-Modeling panel bar, is used to prepare the part for 

publishing. The tool identifi es the geometry used for placement, sets the parameters, and modi-

fi es the part so Frame Generator can use it.

This example uses a rubber bumper iPart fi le like might be attached to frames to guard 

against impact. In the iPart table there are parameters to control the dimensions and three sizes 

defi ned. If this were a true frame member profi le, the engineering properties (moments of iner-

tia and so on) might need to be calculated, and therefore that information would be set up as 

well. Since this isn’t a load-bearing part, those properties aren’t required. To explore the author-

ing process, follow these steps:

 1. On the Get Started tab, click the Open button.

 2. Browse for mi_15a_020.ipt located in the Chapter 15 directory of your Mastering 

Inventor 2015 folder and click the Open button.

 3. From the Manage tab, locate the drop-down list on the Author panel and then click the 

Structural Shape button.

 4. When the authoring tool starts, everything is blank. Once a category is selected, the dia-

log box will update with the appropriate controls. Because this is an unusual part, select 

the Other category, as shown in Figure 15.36.

Frame Generator looks in the Structural Shapes category only, so you have to select one 

of the standard categories or create a new one in the Content Center Editor. You can’t add 

a category through the authoring tool, so you have to add the category to Content Center 

before authoring. See Chapter 7, “Reusing Parts and Features,” for more information on 

Content Center.

Since there is only one extrusion in the part, the base feature is automatically selected. 

The default base point is indicated at the center of the profi le. For this part, the inside cor-

ner of the fl anges is the natural insertion point.

 5. Click the drop-down list, choose Select Geometry, and then select that point in the model, 

as shown in Figure 15.37. Note that you may need to use the ViewCube® to look at the end 

view of the part to see the insert point selection.
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Figure 15.36

Selecting the 

category

Figure 15.37

Selecting the 

default base point

The Notch Profi le option is used when you are authoring frame members and you want 

to include a predefi ned notch profi le to be used with the Notch tool. In this case, there is 

no notch profi le.

 6. Click the Parameter Mapping tab.

 7. Set the Base Length row to use the Length parameter by clicking the Please Select cell in 

the table and then choosing Length from the list.

The Parameter Mapping tab has one required fi eld: Base Length. This is the param-

eter for the extrusion distance. Since this is an iPart, when you click in the fi eld, the 
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iPart properties are listed, as shown in Figure 15.38. If this were a regular part, the Part 

Template Parameters dialog box would display a browser tree, as shown in Figure 15.39. 

The rest of the parameters are optional. They are mechanical properties of the profi le nec-

essary for calculating loads with the Beam And Column Calculator.

Figure 15.38

Specifying the 

length parameter 

for an iPart

Figure 15.39

Specifying 

parameters for a 

regular part

When the geometry and Base Length parameter are mapped, the Publish Now and OK 

buttons are enabled.

 8. Click the OK button to update the part with the authoring changes.
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Clicking either the Publish Now or OK button will update the part and close the dialog 

box. Publish Now will also launch Content Center publishing wizard. Once the part is 

updated, a dialog box displays with information about the changes. A log fi le that lists 

the changes to the part, as shown in Figure 15.40, is created in the project directory.

Figure 15.40

Log fi le for an 

authored part

 9. Click the OK button in the Structural Shape Authoring notice dialog box.

 10. You can close the fi le without saving changes or use this fi le to explore the publishing 

options.

If you inspect the part after authoring, you will see that the browser and parameters have 

been updated. The details of the model and parameters are discussed in the section “Exploring 

the Anatomy of a Frame Member” earlier in this chapter.

Test Before You Publish

Before you publish the member for your team to use, be sure to test it in every conceivable situation. 

Even a seemingly well-constructed frame member can cause issues after end treatments are applied.

Publishing a Part
The publishing process uses the Publish Guide Wizard. Since the part was authored, most of the 

publishing information has already been added to the fi le. If you aren’t familiar with publishing 

to Content Center, review Chapter 7.

These publishing steps are important for Frame Generator:

 ◆ When you defi ne the family key columns, the Length parameter must be set as a key 

column.

 ◆ In the Family Properties pane, the standard organization is used to categorize the member 

during insertion. If you leave this fi eld blank, the category selection will be Unknown.

 ◆ In the thumbnail image pane, a special thumbnail is displayed. Since the thumbnail is used 

as the orientation image in the dialog boxes, it is important to use the thumbnail that Frame 

Generator creates.
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Frame Assemblies and BOMs
By default, Frame Generator parts are set to calculate their base quantity from the length of the 

part. This differs from standard parts that calculate their base quantity from the number of 

parts in the assembly. When parts are authored for use in Frame Generator, the Base Quantity 

setting is automatically set to the length. To get a part count in the parts list for your assemblies, 

you will want to confi gure them to read the item quantity rather than the base quantity. You can 

use both columns if that fi ts your needs, or you can have the BOM display one quantity and the 

parts list display the other.

You can also use the BOM expression builder to create a description built off the Stock Number 

property and GL parameter (Length). You can use the CUTDETAIL parameters in expressions to 

show the end treatment information for each member. Note that you can copy the expression 

in one cell of the BOM, multiselect the rest of the column, and then right-click and choose Paste 

to set the expression to all of the parts in the BOM. Figure 15.41 shows the BOM Editor list-

ing the base quantity and the item quantity along with an expression being built to fi ll out the 

description.

Figure 15.41

Using the BOM 

expression builder

It is a good idea to let Frame Generator name the frame members for you and use the Part 

Number property rather than the part name to manage the parts. Once you’ve set an expression 

as just described, you can sort the BOM by that column to group the like items, set one of the 

part numbers, multiselect the items, and choose Paste from the context menu to set them 

all the same. If you want the items to be merged, leave the Part Number Merge Settings options 

selected. The Part Number Merge Settings button is in the top right of the BOM Editor 

dialog box.

In the drawing environment, use a Parts List style similar to the default Material List style 

found in the standard templates. This parts list is already confi gured to group by stock number 

and material, as well as sum the values of each unique stock number type. Figure 15.42 shows a 

parts list placed using the Material List style to roll up the lengths.

Figure 15.42

A parts list using 

the Material List 

style
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Th e Bottom Line

Work with frame fi les.  Frame Generator puts all the members at the same level in the 

assembly.

Master It  You have a frame that is built up in sections that are welded together. How do 

you document the manufacturing process?

Insert frame members onto a skeleton model.  Frame Generator builds a skeleton model for 

the frame from the selected lines and edges.

Master It  Since Frame Generator builds its own skeleton model, you don’t have to build 

a master model before you start creating the frame. What would you reference in your 

assembly to use as a frame skeleton?

Add end treatments to frame members.  Frame Generator does not support end treatments 

on merged members.

Master It  Let’s assume you are building a stairway and the handrail has curved sec-

tions. How would you approach the curved handrail so that its ends can be treated?

Make changes to frames.  Inventor provides detailed frame-member information.

Master It  You need to determine the size and wall thickness of the tubing and make it 

either thicker or larger. How do you do that?

Author and publish structural profi les.  Frame Generator uses structural shapes from 

Content Center.

Master It  How would you add custom aluminum extrusions to Content Center so 

Frame Generator can access them?

Create BOMs for Frame Generator assemblies.  Frame Generator has special parameters 

for frame members.

Master It   How do you add the profi le dimensions and the length of your frame mem-

bers to the Description fi eld?




